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AP guide to…

Your image has been retouched and 
is ready to print, but how can you ensure 
that you achieve a print you would be 
happy to display? There are many factors 
that contribute to a professional-looking 
print from a correctly exposed digital 
image. Along with advice from printing 
professionals, I will take you through how  
to prepare your image and your inkjet 
printer for the best possible results. 

work space
David May, production manager at The 
Printspace in East London, stresses the 
importance of a good working area. ‘Making 
minor adjustments to image detail 
and colour rendition will be tricky 
with glare from bright sunlight 

Professional printing
Professional-quality prints 
can be difficult to achieve. 
Tim Coleman outlines the 
key factors to get what you 
see on-screen, on paper 

A neutral 
environment with 
consistent light 
helps your eyes 
when checking for 
colour accuracy

the printspace
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getting the 
image ready
 

Step One Resolution
An inkjet printer uses nozzles to spray ink onto 
the paper, typically at a resolution of 360dpi. 
As a general rule, therefore, 360ppi is the ideal 
resolution for image files because the quality 
cannot be improved with a higher output. 
Straight out of the camera, the resolution of 
digital files is usually 72ppi, so this needs to 
be altered before printing. Although 360dpi 
is the ideal resolution for image files, you can 
use 240ppi or 180ppi for cameras with lower 
resolutions. When altering the ppi resolution, 
uncheck the Resample Image box first, alter 
the ppi resolution and then recheck it. The 
document size will change, but the pixel 
dimensions will remain the same. Do not 
increase the pixel dimensions drastically as you 
cannot create data from nothing, while if you 
make huge reductions in the pixel dimensions 
the quality will be reduced. 

Step Two Image size
Most DSLRs shoot in a 3:2 format, which may not 
match the format you wish to print. Use the Crop 
tool to adjust the format by typing in the correct 
ratio or dimensions in the Crop tool’s settings. 

Borders are best added to the file rather than 
centring the print through output. This can be 
achieved in Photoshop by increasing the size  
of the canvas to the desired dimensions. 

It is good practice to print the digital file at 
100%. A 240ppi file is 150% larger than 
360ppi. If you want to print larger, then 
compromising resolution is fine because it is 
difficult to spot any difference between 240ppi 
and 360ppi. This maintains the pixel dimensions 
to the output of the camera sensor, which in a 
12.1-million-pixel camera in 4:3 format has 
an output of 4000x3000 pixels. For larger 
changes, resampling the image can be a better 
option. To do this, check the Resample Image 
box, and use Bicubic Sharper for reducing the 
size and Bicubic Smoother for enlarging.
 
Step Three Colour check
Poor colour rendition is most obvious in shadow 
areas. Look at the blacks in the image to check 
for a colour cast and at the highlights as these 
are also good indicators. If you are unsure about 
the colour balance, look for known colours in 
the scene, such as the colour of a wall, and then 
use that as a guide. If this becomes tricky, then 
balance the colour for the most important aspect 
of the image. In a portrait, for example, this 
would typically be the skin tone. 

Step Four Levels
Images with blown-out highlights, which are seen 
as areas of white, can cause a problem when 
printing. Because there is no data in this part of 
the image, the printer will not output any ink on 
this area, essentially leaving patches on the paper 
with no ink at all. Adjusting the Levels helps to 
avoid this problem. If you adjust the highlight to 
252 on the output slider this should add enough 
data for the printer to distribute ink in these areas 
without affecting the image quality too much. 
Alternatively, dull down the area by pulling down 
the highlights via Curves. Both of these options 
will mean that the image has a little less contrast, 
but the print will have total ink coverage.

Step Five The final edit
For a crisp and sharp print, add a bit of 
sharpening as a final touch. Set the view size 
somewhere between 33% and 50% (at 100% 
you risk sharpening too much) and increase the 

Image size

Resolution

Canvas size Levels

sharpening until you are happy with the print.  
Go to View>Print Size as a final check. 

Because a monitor is effectively a lightbox, it is 
an ideal way to view and edit an image. However, 
what appears on screen is brighter than what 
will be produced on inkjet paper. To adjust for 
this, lighten the image by 10% before printing. A 
calibrated monitor has a more accurate output. 
Otherwise, you can darken the monitor by 10% 
and make final image adjustments.

Once you are ready to print, view a soft proof 
to see how the image will look in accordance 
with the printer and paper being used. Go to 
View>Proof Setup>Custom... Device to Simulate 
to see how the print will look. Under this heading 
you will see a list of ICC profiles already loaded 
into Photoshop (see ICC profiles on page 60). 
Choose your desired paper. There is a discernible 
difference between papers, particularly in bright 
blue and red areas of an image. C-type paper is 
less vivid, but the tonal range is good. Select the 
correct rendering intent (see Output, opposite 
page) and then click OK. Finally, make your final 
colour and Levels adjustments. 

Step Six File format
Before printing, make sure the file is flattened 
of all adjustment layers. Using the TIFF format 
from a raw file is ideal for image editing, and 
Photoshop users will be equally pleased with 
PSD files. JPEG files compress information and 
are not ideal for editing, but once the final edit 
is complete, it is difficult to see the difference 
between any of those formats.

Curves
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l Calibrate your monitor
l Use a consistent light source in 		
your work environment, and surround 
yourself with neutral colours 
l Work from Adobe raw and steer 
away from jpeg format
l Use a compatible print resolution 
to the size of your camera sensor 
l Check that you are using the correct 
Rendering Intent
l A custom ICC profile ensures the 
correct colour values and ink output
l Run a test print to avoid wasting 
paper and inks

shining on your monitor,’ he says. ‘Try to work 
in an environment away from strong light 
and with a consistent level of light.’ A monitor 
hood shields your screen from strong light 
and allows the monitor brightness to be 
turned down, which is energy efficient. Try 
the Colour Confidence PCh00D Monitor 
Hood Pro, which costs £71.44 from www.
colourconfidence.com (see AP 23 October 
2010). Use a neutral colour, such as grey, for 
your desktop background and restrict bright, 
distracting colours within your vision. 

It is important to view prints in daylight 
conditions. Bright light is not helpful to see 
image detail, but neutral overcast light is 
good. There are plenty of options when it 
comes to daylight-balanced light sources, 
and some are very reasonable. For example, 
the Daylight Company sells portable lamps 
from £54.99 (www.daylightcompany.com).

Calibrating your monitor is a key part of 
your preparation. There is a software option 
to calibrate your monitor that relies on the 
human eye, but for best accuracy hardware 
calibration devices ensure the colour 
rendition and levels are correct. 

The X-Rite i1 Display 2 is a popular 
choice for professionals (available for 
£150 from www.colourconfidence.com). 
Monitors should be calibrated every six 
months or so, but if you do a lot of printing 
this should be every two months. Some 
photo labs, including The Printspace (www.
theprintspace.co.uk), offer a monitor-
calibration service for free if you can take it 
to the store, which is useful for laptop users. 
 
Colour space
Colour space comprises all possible colours 
created from red, green and blue (RGB). 
The limit of these colours is defined by 
the colour gamut. For top-quality prints, 
using Adobe RGB in-camera and on 
computer is better than sRGB, because it 
has a larger colour gamut. This is particularly 

noticeable in the green, blue and cyan 
areas, all of which are particularly important 
to landscape photographers. sRGB was 
designed for web use, so is ideal for online 
images. For black & white prints, work from 
Adobe RGB desaturated. It is best to match 
the working colour space that the image 
was recorded with, and this can be found 
through Edit>Color Setting in Photoshop.

Output
Once the image has been edited, the 
settings for output must be set correctly. 
As a default, most printers are set to use 
high-speed mode. This in turn affects image 
quality, so make sure this option is not 
selected. Also, uncheck the box for colour 
management, because this is being carried 
out manually, and make sure the image is 
the correct size for the print you require.

Rendering intent tells you how to deal with 

Many thanks to 
David May from 
The Printspace, 
Vij Solanki from 
Permajet, Dominic 
Fowler from Epson 
and Estelle Sexton 
from Canon for their 
help with this article

the colours you cannot reproduce - those 
out of the colour gamut. As a default, this is 
set to Relative Colormetric. In this setting the 
white of the source colour space and that of 
the destination space (printer) are compared 
and colours are shifted accordingly. Out-
of-gamut colours are shifted to the closest 
match, which means accurate colours are 
maintained. The tone is then flattened, so 
it is less able to render shadow detail and is 
therefore best for use for brighter images. 

Perceptual is the alternative option, which 
shrinks the whole colour gamut down to fit 
within the smaller gamut of the printer. The 
relationship between colours is maintained, 
but this often means there will be a shift in 
colour values. This option holds shadow detail, 
making it best for images with dark areas and 
shadow detail. Check the correct 
option when viewing a soft proof to 
ensure accurate colour management. 

Above: Even with 
instant dry paper, 
leave prints to dry 
completely and 
handle with gloves

A viewing booth is useful to check 
prints under controlled daylight-
balanced lighting

the printspace

David may
Top tips
Production director  
of The Printspace
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ICC profiles
I spoke to Vij Solanki from Permajet to get his 
thoughts on the importance of ICC profiles. He 
said: ‘An ICC profile holds information about 
the range of colours that a printer or monitor 
can utilise. To obtain accurate colour rendition, 
particularly in shadow areas, it is vital to use the 
correct ICC profile. The default information will  
be correct if you use, for example, an Epson 
printer, Epson ink and Epson paper. However,  
if any one of these variables is changed, then  
the default is incorrect. Your operating system  
is also a variable.’ 

It is fairly straightforward to download the 
correct generic ICC profile to match your printer, 
ink and paper combination through the website 
of the paper brand you are using. This will 
improve the accuracy of print, but it is a profile 
that has been created on another printer. Every 
printer is unique and performs slightly differently. 
The same profile and output may be fine on one 
printer, but could show a slight cyan tinge on 
another and even a variable such as humidity 
can influence the outcome of the print. So for 
the most accurate colour rendition it is worth 
investing in your own unique ICC profile that is 
specific to your printer. 

Software to do this is available, such as Canon’s 
Colour Management Tool Pro 2. Alternatively, 
Permajet provides give free advice when using its 
paper, but charges for other papers. This process 
includes downloading two generic colour patches, 
printing them off with no colour management 
or manipulation, and sending them off to the 
company. For more details visit www.permajet.
com. There is online ‘remote’ ICC profiling, but  
for the best accuracy it is best to send off the 
colour patches.

printer maintenance
It is possible to get all the output and printer 
profiling correct, but still have an unsatisfactory 
print. If you are not happy with the print you have 
produced, begin by running a nozzle check. This 
can be found through the printer setup and will 
indicate if there is any issue with the mechanics 
of the printer, such as head alignment, and if 
the heads are clean and clear. It takes just a 

paper-feeding issue to misalign the print heads. 
If it has been a while since the printer was last in 
use, the print heads may need cleaning. In the 
UK, long-term storage is less likely to be an issue 
in terms of clogged printer heads, whereas a hot, 
dry climate is more problematic. Give pigment ink 
cartridges a shake before use in this instance.

Cleaning a print head uses up ink, but it is 
cheaper than wasting a sheet of expensive photo 
paper. Complete a nozzle check first to avoid the 
unnecessary wasting of ink. 

ink choice
For professional-quality prints, using the printer 
manufacturer’s own or top-quality third-party 
inks is important. Cheaper, poor-quality third-
party inks have several downsides. For example, 
an ICC profile may not exist for the ink, and the 
longevity of third-party inks is much lower, leading 
to faded prints. The general density and saturation 
of the inks will produce poorer results, too.

Permajet’s continuous-flow system is one 
example of good-quality third-party inks. 
A complete system costs £260, with each 
cartridge holding 125ml of ink. The company 
claims this produces an 80% saving on 

ink and that the ink quality is even more 
saturated and equal in longevity to the print 

manufacturer’s own ink. Each cartridge is 
replaceable for £26.95. Manufacturers’ 

inks are expensive. A complete set 
of inks for a printer such as the 

Epson Stylus Photo R2880 will 
cost just under £100. Each ink 

cartridge holds 11ml of ink, 
although this can produce 
less than 10ml of usable ink.

paper choice
Depending on your image and the way you 

wish to present it, your choice of paper is key. 

Typically, gloss paper is a popular choice because 
the high-contrast, bright and saturated colours 
make for bold prints. Paper with a baryta layer 
has many of these advantages, but with a greater 
choice of finishes and thicknesses. Matt and 
textured paper can give a nice arty feel, but often 
this results in more muted colour reproduction, 
limited contrast and loss of detail. Also, the base 
colour of the paper affects the warmth of a print. 

Each paper has a different level of texture, so 
setting the correct paper type is important for an 
accurate level of ink output.

Feeding
Sheets of paper that are dense and thick may 
not feed through the printer correctly. Typically, 
sheets over 300gsm will need to go through 
individually, or in some cases through another 
feeder on the printer, but read the manual of 
your printer to make sure. If the printer is stacked 
with several sheets, it may feed more than one 
through at a time and throw the printer head out 
of alignment, which will consequently need fixing. 

Handling
Although most inkjet papers produce prints that 
are dry straight from the printer, it is worth handling 
them as little as possible to make sure they are 
thoroughly dry. When handling prints, particularly 
with a gloss finish, fingermarks can spoil the 
surface, so wear gloves to avoid any damage. 

Test prints
To save money on ink and paper, run a test strip, 
much like in darkroom printing. It is advisable to 
do this for both sharpening and colour balance, 
set at incremental levels. Use the same section of 
the image with key points of interest. When you 
print, uncheck the centre image box and move 
the strip along the page setup from left to right so 
the strips do not overlap.

getting the printer ready
Using 

manufacturers’ 
own inks ensures 
the best possible 

quality prints

The different fibre 
base of these 
papers affects the 
warmth of tone


